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This tutorial comes from the EDC Simulations seminar. It provides a good
example of the use of the driver input tables. In particular, it illustrates how the
driver tables use linear interpolation to compute the current steer angle.
The goal of this tutorial is simply to make the simulated vehicle follow the
desired path. Only steering is required, so the scope is limited, but extremely
useful.
Like all EDSVS events, the procedures involve the following basic steps:
 Create the vehicles
 Create the environment
 Execute the EDSVS event
 Review the EDSVS output reports
These basic procedures are described in detail in this tutorial.

It is assumed that HVE-2D is up and running, and
+ NOTE:
that the user is familiar with HVE-2Ds basic features,

such as using HVE-2Ds dialogs and viewers, as well as
the HVE-2D Editors. The purpose of this tutorial is to
illustrate those features while setting up and executing an
EDSVS event.
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Getting Started
As in other tutorials, before we get started with our current tutorial, lets set the
user options so were all starting on the same page.

In HVE-2D, all options simply affect the appearance
+ NOTE:
in a viewer during Event or Playback mode.
in HVE, AutoPosition affects the data used in
+ However,
the analysis. For example, if AutoPosition is On, the

vehicle position conforms to the local surface; otherwise, the
position is set by the Position/Velocity dialog. Obviously, the
resulting difference in initial conditions could substantially
change the event.
Some of the following options are Toggles that
+ NOTE:
switch between two different modes. Make sure these
options are set correctly.
To set the initial user options, choose the following from the Options Menu:
â ON: Show Key Results
â OFF: Show Axes
â ON: Show Contacts
â OFF: Show Velocity Vectors
â ON: Show Skidmarks
â OFF: Show Targets
â ON: AutoPosition
â Units equals U.S.
â Render Options:
 Show Humans as Actual
 Show Vehicles as Actual
 Phong Shading Mode
 Complexity equals Object
 Render Quality equals 5
 Texture Quality equals 1
 Anti-aliasing equals 1
The remaining options will automatically initialize to their default conditions.
Were now ready to proceed with the tutorial.
Our goal is to use EDSVS to drive a 1997 Ford Explorer along the path
described in Figure 5-1, shown on the following page. This tutorial shows us
how to perform this simulation.
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(-150,-10,180)
Figure 5-1 Path for EDSVS Simulation Tutorial
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Creating the Vehicle
Now lets add the vehicle to our case. The vehicle is a dark green 1997 Ford
Explorer:
â If the Vehicle Editor is not the current editor, choose Vehicle
Mode. The Vehicle Editor is displayed.
â Click Add New Object. The Vehicle Information dialog is
displayed. The Vehicle Information dialog allows the user to
select the basic vehicle attributes according to Type, Make,
Model, Year and Body Style.

The Vehicle Information dialog also allows you to
+ NOTE:
edit the Driver Location, Engine Location, Number of
Axles and Drive Axle(s). The Ford Explorer is a 4-wheel
drive vehicle, but were going to select 2-wheel drive for
the tutorial.

â Using the option buttons, click each button to choose the

following vehicle from the database:
 Type = Sport Utility
 Make = Ford
 Model = Explorer
 Year = 1995-1999
 Body Style = 4-Door
 Drive Axles = Axle No. 2
â Click OK to add Ford Explorer 4-Dr to the Active Vehicles
list.
The Ford Explorer is displayed in the viewer, as shown in Figure 5-2.
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Figure 5-2 Ford Explorer 4-Dr, before editing.
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Figure 5-3 Vehicle Color
dialog, used for assigning the
vehicle color.

Editing the Vehicle
Next, we will edit the vehicle to change its color and weight. To edit the color,
perform the following steps:
â Click on the CG (the CG may be hidden under the seat or other
interior object; however, the CG icon is located at the vehicle
CG; therefore, if you click at the intersection of lines
connecting the exterior balls (left-right and front-rear), you
will select the CG) and choose Color. The Vehicle Color
dialog is displayed (see Figure 5-3), showing the vehicles
current color (the small black square, or hot spot, in the color
wheel) and intensity (the arrow in the intensity slider). Click on
the hot spot and drag it to the middle of the green area. To
darken the vehicle, click on the intensity slider and drag it from
the right end of the slider towards the middle.

+ NOTE: The color chip on the left shows the current color.
â When the color is darkened to your liking, close the dialog by

clicking the close button on the upper right corner of the dialog.

The vehicles apparent color may be slightly
+ NOTE:
misleading because the vehicle is translucent when

displayed in the Vehicle Editor. The actual color will be
used whenever the vehicle is displayed during Event and
Playback mode.
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Figure 5-4 Vehicle Inertias dialog, used for editing the
current weight and yaw inertia. The values in this
dialog are customized for this simulation.

TUTORIAL

Next, lets change the weight. Perform the following steps:
â Click on the CG and choose Inertias. The Inertias dialog is
displayed (see Figure 5-4), and were ready to change the
vehicles weight.

Only total weight and yaw inertia is used by the
+ NOTE:
3-DOF EDSVS calculations.
â In the Total Weight text field, replace the existing weight,

4295, with the measured value, 4405 lb.

The dialog might display 4294.836, or similar
+ NOTE:
number, because the weight is actually divided by the
current gravity constant and stored as mass. Extra
precision results when the mass is multiplied by the
current gravity constant and redisplayed.

â Press OK to accept the weight value.
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Creating the Environment
Now, lets add the environment:
â Choose Environment Mode. The Environment Editor is
displayed.
â Click Add New Object. The EnvironmentInformationdialog is
displayed.
â Using the Location Database combo box, choose Beaverton,
Oregon, USA. The latitude, longitude and GMT (hours from
the prime meridian) are displayed for the selected location.
â Enter the date and time of the incident we are studying,
8-8-97 and 1230, respectively.
â Enter the angle from true north to the earth-fixed X axis in our
environment, 165 degrees.

The Latitude, Longitude, GMT, Date/Time and
+ NOTE:
angle from true north are used to position the sun in the
scene. This is, of course, important because the sun is
the primary light source for the scene.

â To add the environment geometry file to our case, click on
Open.

The Environment Geometry File Selection dialog is
displayed.
â Click on the File Format option list and choose h3d Files. A
list of environment geometry files using the .h3d file format is
displayed in a list box. Double-click on EdsvsTutorial.h3d to
choose the environment file and remove the dialog.
â Press OK.
The selected environment is added to our case and displayed in the
Environment Viewer (see Figure 5-5). Use the viewer thumb wheels and/or
manipulators to view the scene.

Saving the Case
Now that weve created all the objects (vehicle and environment) for our case,
lets save the case file.
â Click on the File menu and choose Save. The Save-as File
Selection dialog is displayed.
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Figure 5-5 Environment used for our EDSVS tutorial.

The Save-as dialog is displayed because the
+ NOTE:
case has not been saved previously, so we need to enter
a filename.

â Place the mouse cursor in the Case Title text field and enter

EDSVS Tutorial Case.

The Case Title is displayed as a heading on all
+ NOTE:
printed output reports.
â Place the mouse cursor in the Filename text field and enter

EdsvsTutorial.
â Click SAVE. The current case data are saved in the
HVE2D/supportFiles/case subdirectory.

Saving the file occasionally is a highly
+ NOTE:
recommended practice.
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As mentioned at the outset of the tutorial, we are going to simulate a vehicle
traveling along a pre-determined path to learn more about the use of HVE-2D driver
tables. To create the event, perform the following steps:
â Choose Event Mode. The Event Editor is displayed.
â Click Add New Object. The Event Information dialog is
displayed.
â Select Ford Explorer 4-Dr from the Active Vehicles list.
â Select EDSVS from the Calculation Method options list.
â Enter a name for the event, Steering Maneuver.

HVE-2D will append the name of the calculation
+ NOTE:
method to the event name, thus the complete event
name will become EDSVS, Steering Maneuver.

â Press OK to display the event editor.

Now, were ready to set up the event.
â Using the Event Editor dialog, select Ford Explorer 4-Dr from
the Event Humans & Vehicles list, then choose Set-up from the
menu bar and select Position/Velocity. The Explorer is
displayed at the earth-fixed origin.
â Click on the vehicles X-Y manipulator (see Figure 5-6), wait
for it to turn bright yellow (indicating it has been selected), and
drag it to its initial position, X=-30 ft, Y=-10 ft. Click the
yaw manipulatorand rotate it to its heading angle, 0 degrees.

To select the X-Y manipulator, the viewer must be
+ NOTE:
in Pick mode, as indicated by the highlighted arrow in the

upper right corner of the viewer (see Figure 5-6).
Be sure to keep the mouse button depressed
+ NOTE:
while you drag the manipulators.
Adjust the viewer by dollying back (using the Dolly
+ NOTE:
thumb wheel) until you can see the entire course.
If you cant position the vehicle at the exact
+ NOTE:
coordinates, simply enter them in the dialog (in fact, its
often easier to directly enter the coordinates using the
dialog, especially for heading angle).

â Click the Velocity Is Assigned checkbox. Enter the initial

velocity, 20 mph, then click Apply.
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Figure 5-6 Vehicle positioning using the HVE-2D Event Editor. The manipulators can be
used to drag and drop the vehicle into position.
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When entering coordinates and velocities using
+ NOTE:
the Position/Velocity dialog, remember to press <Enter>;
otherwise, the values will not be assigned.

The vehicle initial conditions are now established. Lets enter the driver
controls. But, before we enter the steer angle data, lets be smart: Although we
could simply find the steer angles by trial and error, instead well use a simple
formula to arrive at a very good estimate. From the vehicle wheelbase and
desired path radius, it can be shown the required steer angle is approximated
by:

(

δ = arctan wheelbase

)

radius

The accuracy of this estimate is normally an
+ NOTE:
acceptable initial estimate unless the vehicle is
sideslipping.

5 - 11

EDSVS

Creating Events

Noting the wheelbase of the vehicle is 112 inches and the desired path radius is
50 feet (600 in), the required steer angle is about 11 degrees at the wheels.

An initial attempt using 11 degrees caused the
+ NOTE:
vehicles path to be too large. Well use 11.25 degrees in
our table.

To enter the steer angles, perform the following steps:
â Click on the Set-up Menu and select Driver Controls. The
Driver Controls dialog appears and the Steering Table is
displayed.
â Click on the Table Is option list and choose the At Axle option.
â Enter the steer angles for the front wheels, as shown below:
Table 5-1 Steering Table for the EDSVS, Steering Maneuver event.

Steer Angle at Axle (degrees)

Time
(sec)

Axle 1, Right

Axle 1, Left

0.50

0.00

0.00

0.60

11.25

11.25

9.50

11.25

11.25

10.00

-11.25

-11.25

12.65

-11.25

-11.25

13.75

0.00

0.00

â Press OK to accept the steering table.

This event lasts more than 5 seconds. To prevent premature termination, lets
increase the default maximum simulation time.
â Click on the Options menu and choose Simulation Controls.
The Simulation Controls dialog is displayed.
â Edit the Maximum Simulation Time, changing it from 5 to 20
seconds.
â Press OK to update the simulation controls.
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Figure 5-7 Key Results Variable Selection dialog, used for
selecting variables to be displayed in the Key Results window.

Since our goal for this event is to follow a desired path, lets look at some Key
Results during execution:
â If Key Results windows are not displayed, choose Show Key
Results from the Options menu.
â Drag the Key Results windows to a convenient location, where
they do not block the view but still allow us access to the
viewer thumb wheel controls (in case we want to change the
view).
â Click on Select Variables in the Ford Explorer 4-Dr Key
Results window. The Variable Selection dialog for Ford
Explorer 4-Dr is displayed.
Lets add Wheel Fx, Fy, Fz and Steer Angle to the Key Results window:
â Choose Wheels, Axle 1, Right from the variable output groups
list. The Variable Selection list for the right front wheel is
displayed (see Figure 5-7, above).
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â Select Fx, Fy, Fz wheel forces and Delta (whl) (Steer Angle)

from the list.

The above procedure adds the forces for the right
+ NOTE:
front wheel only; you might wish to add the variables for
the remaining three tires.

â Press OK to add the selected variables to the list.

Now, were ready to execute the event.
â Using the Event Controller, click Play to execute the event.
Allow the event to run until completion at t = 20 seconds.
The EDSVS event is shown at time, t = 3.10 seconds in Figure 5-8. Note
the vehicle travels within 2 feet and 2 degrees of each path position
defined in Figure 5-1.

While the event is executing, watch the current
+ NOTE:
results (especially the X,Y path coordinates and heading
angle) in the Key Results windows.

We have now completed the event.
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Now that we have produced our EDSVS simulations, lets take a detailed look
at the results. The Playback Editor is used for reviewing and printing reports
for each event in the current case, as well as for producing video output.
EDSVS produces the following reports:
 AccidentHistory- A table of initial and final positionsand velocities
 Messages - A list of messages produced by the current run
 Program Data - A table containing program control information
 Trajectory Simulation - A visualization of the event, displayed at a
user-selectable time interval
 Variable Output - A table containing time-dependent simulation
results
 Vehicle Data - A series of tables containing the vehicle data used by
EDSVS
To view the output reports, we need to be in Playback mode:
â Choose Playback Mode. The Playback Editor is displayed.
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Figure 5-8 HVE-2D Event Editor executing the EDSVS Event.
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Report Windows
The reports listed on the previous page are displayed by selecting Report
Windows. Each Report Window contains an individual report.

Figure 5-9 Report Window Information
dialog, showing the name of the
event(s)in the current case.

To view the reports produced by the EDSVS, Steering Maneuver event,
perform the following steps:
â Click Add New Object. The Report Window Information
dialog is displayed, as shown in Figure 5-15, and includes a list
of the active events (EDSVS, Steering Maneuver is the only
event in this tutorial). The Report Window Information dialog
also includes the user-editable Report Window Name text field
and Selected Output option list.
â Select EDSVS, Steering Maneuver from the Active Events list.
â Click on the Selected Output option list and choose any of the
available reports.
â Press OK to display the report.
The selected report will be displayed in a resizable window. The following
pages illustratethe reports producedfor the EDSVS, Steering Maneuver event.
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Accident History
The Accident History report displays the time and total distance traveled, as
well as position and velocity information for the start and end of the run.

To view the Accident History report for the EDSVS, Steering Maneuver event,
perform the following steps:
â Click Add New Object. The Report Window Information
dialog is displayed.
â Select EDSVS, Steering Maneuver from the Active Events list.
â Click on the Selected Output option list and choose Accident
History.
â Press OK.
The Accident History report is displayed for the EDSVS, Steering Maneuver
event, as shown in Figure 5-10.

The Accident History report and several other
+ NOTE:
reports contain more information than fits into the default
window size. Use the scroll bars or resize the dialog to
view the entire report.
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Figure 5-10 Accident History Report for EDSVS, Steering Maneuver.

EDSVS

Viewing Results

Messages
EDSVS produces a number of messages, depending on the outcome of the
event. For a complete list and explanation of the messages produced by
EDSVS, see Chapter 6.

Figure 5-11 Messages History Report for EDSVS, Steering Maneuver.

To view the Messages report produced by the EDSVS, Steering Maneuver
event, perform the following steps:
â Click Add New Object. The Preview Window Information
dialog is displayed.
â Select EDSVS, Steering Maneuver from the Active Events list.
â Click on the Selected Output option list and choose Messages.
â Press OK.
The Messages report is displayed for the EDSVS, Steering Maneuver event, as
shown in Figure 5-11.

5 - 18

Viewing Results

Tutorial

Program Data
The Program Data report for EDSVS displays the simulation controls used for
the current event.

To view the Program Data report for the EDSVS, Steering Maneuver event,
perform the following steps:
â Click Add New Object. The Report Window Information
dialog is displayed.
â Select EDSVS, Steering Maneuver from the Active Events list.
â Click on the Selected Output option list and choose Program
Data.
â Press OK.
The Program Data report is displayed for the EDSVS, Steering Maneuver
event, as shown in Figure 5-12.
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Figure 5-12 Program Data Report for EDSVS, Steering Maneuver.
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Vehicle Data
The Vehicle Data report displays the vehicle data, tire data and driver control
tables for the EDSVS vehicle.

Figure 5-13 Vehicle Data Report for EDSVS, Steering Maneuver.

To view the Vehicle Data report for the EDSVS, Steering Maneuver event,
perform the following steps:
â Click Add New Object. The Report Window Information
dialog is displayed.
â Select EDSVS, Steering Maneuver from the Active Events list.
â Click on the Selected Output option list and choose Vehicle
Data.
â Press OK.
A portion of the Vehicle Data report is displayed for EDSVS, Steering
Maneuver is shown in Figure 5-13.
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To view the Variable Output report for the EDSVS, Steering Maneuver event,
perform the following steps:
â Click Add New Object. The Report Window Information
dialog is displayed.
â Select EDSVS, Steering Maneuver from the Active Events list.
â Click on the Selected Output option list and choose Variable
Output.
â Press OK.
The Variable Output report is displayed for the EDSVS, Steering Maneuver
event. The table is initially empty, so the next step is to select the
time-dependent results we wish to display in the table.
The purpose of our EDSVS study is to make our vehicle follow a desired path.
To document the resulting path, as well as some other pertinent results, lets
select the CG path coordinates and path radius from the Variable Selection
dialog.
â Click on Select in the Variable Output window. The Variable
Selection dialog for Ford Explorer 4-Dr is displayed, as
shown in Figure 5-14.
The Kinematics Output group is the default selection and the Kinematics
variable list is displayed. Lets add X, Y, Yaw and Path Radius to the Variable
Output window:
â Select X, Y, Yaw and Radius from the list .
Next, let add the right front tire forces and steer angle:
â Choose Wheels, Axle 1, Right, from the variable groups list.
The Variable Selection list is displayed.
â Select Fx, Fy, Fz and Delta (whl) from the variable list

Feel free to add additional variables to the
+ NOTE:
Variable Output window.
â Press OK to add the selected variables to the Variable Output

window.
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Figure 5-10 Variable Selection dialog, used for selecting the
results displayed in the Output Report. The above variable list is
displayed after selecting the Wheels group and selecting Axle 1,
Right Side.

The Variable Output report for the EDSVS, Steering Maneuver event now
includes X,Y path coordinates and heading angle, path radius, and right
front Fx, Fy, Fz tire forces, steer angle, plus any other variables you may
have added (see Figure 5-15).
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Figure 5-11 Variable Output report for EDSVS, Steering Maneuver, displaying the selected
results.
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Trajectory Simulation
Finally, lets display a trajectory simulation for this event. To view the
Trajectory Simulation for the EDSVS, Steering Maneuver event, perform the
following steps:
â Click Add New Object. The Report Window Information
dialog is displayed.
â Select EDSVS, Steering Maneuver from the Active Events list.
â Click on the Selected Output option list and choose Trajectory
Simulation.
â Press OK.
The Trajectory Simulation viewer is displayed for the EDSVS, Steering
Maneuver event (see Figure 5-16). The vehicle is shown at its initial position.
To visualize the motion, use the Playback Controller to perform the following
steps:
â Click Play (single right-arrow). The simulation begins and is
displayed at the current Playback output interval.
â Click Pause. The simulation stops.
â Click Reverse (single left-arrow). The simulation plays in
reverse.
â Click Rewind (left arrow with bar). The simulation returns to
the start.
â Click Advance to End (right arrow with bar) the simulation
advances to the end of the run.
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Figure 5-12 Trajectory Simulation for EDSVS, Steering Maneuver, displaying the selected
results.

Printing
The final step is to print the above reports. Printing reports is simple. All you do
is choose a report and print it. For example:
â Click on the dialog header of the Variable Output - EDSVS,
Steering Maneuver report. Your selection is highlighted and
the Variable Output window pops to the top of the display (if it
isnt there already), indicating it is the current window.
â Click on the File menu and choose Print. The Print dialog is
displayed, allowing the user to select from several available
print options.

Alternatively, you can click on the print icon in the
+ NOTE:
main menu bar.
â Press OK. The Variable Output report is printed on the system

printer.
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Thats all there is to it! You can print any other report using the same three
steps described above.

The Print dialog provides several options. Refer to
+ NOTE:
the Users Manual for more information.
For several reports it may be best to print in
+ NOTE:
landscape rather than portrait mode.
The font size of both the printed reports and
+ NOTE:
screen display may be changed by clicking on the
Options menu and choosing Preferences. Use the Font
Size option list to change the size.
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